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For the New Director:
Problems & Pitfalls, Avoidance Measures, Remedies
by Bob Gruber

As a new director you may be a bit apprehensive about plowing new ground when you take the reins of your first game. The nervousness
should diminish with time, but different problems will crop up now and then. This paper is intended to help you through some of those
rough spots.

Note, not every problem has avoidance measures and not every problem has a remedy. The table below represents my knowledge of the
subject matter at the time of this writing. Other directors may have additional information. New directors are encouraged to talk with “old
hands” in their circle seeking revisions and additions to this material.
ID

1

Problem / Pitfall

Avoidance Measures

Remedies

Feeling pressured to start the
game before you’re ready

Tell the players it’s important to get the movement
correct from the very start and you need another
minute or two to verify the # of pairs, wait for a
specific pair, wait for a traffic jam, etc.

The remedy—if any—will depend
upon the resultant problem—if any.

Failing to put out boards for a ½
table

2

[ If you fail to put out a Table Marker
for the 1st round sit out—which is
often the last table in play—it’s easy
to fail to put the boards on that table.
Then, after Round 1, it’s easy for
Table 1 to pass the boards to the last
table with players sitting at it rather
than the proper table. ]

Include in your opening Game Description that N-S 1
should pass their boards to Table X. If appropriate,
you might also announce that Table (X-1) gets their
boards from the sit out table, Table X.
Go to the affected tables early in Round 1, and remind
the Norths of the situation.
Try to catch this error early by getting in the habit of
walking the room at the start of Round 2. At each
table verify that the proper boards are being played.
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If you catch this error early, say
before the start of round 3, insert the
omitted boards at the proper table and
put all the other boards at their proper
tables. When scoring the game,
you’ll have to throw a few boards out
when pairs encounter them for the 2nd
time—probably entering NP (non
play) for those boards—but that’s the
best you can do.
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Problem /
Pitfall

Bye stand 1
table too low

3

[ Just past
halfway, two
E-W pairs (at
the highest table
& ½ highest)
meet boards
played in
Round 1. ]

Bye stand 1
table too high

4

[ Just past
halfway, two
E-W pairs (E-W
1 & E-W = { ½
# rounds + 1 })
meet boards
played in
Round 1. ]
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Avoidance
Measures

Remedies

Double
check that
the bye
stand is
equidistant
from the 2
relay tables

Regardless of when the problem is discovered, the correction is done on the round just past halfway.
As soon as the problem is discovered, announce an irregularity in the movement just past the
halfway point, whatever round that happens to be. Tell the players to move normally for the round,
but not to start play; not to even pull the hands from the boards. Then:
1. Move the bye stand to its proper position (up 1).
2. Exchange sets of boards between the bye stand & the table now directly below. (This keeps the
boards in sequential order.)
3. For this round only, have N-S at the table below the bye stand switch with N-S at the highest
table. For scoring, the N-Ss retain their true pair #s. (These 2 N-Ss play E-Ws they met before
& therefore miss an E-W pair. And, of course, ditto for the E-W pairs.)
4. Announce for this round & forward, the relay is between the highest & 2nd highest tables (not the
highest & Table 1).
5. Resume play.
6. After the round, remind the 2 displaced N-Ss to return to their original tables.

Double
check that
the bye
stand is
equidistant
from the 2
relay tables

Regardless of when the problem is discovered, the correction is done on the round just past halfway.
As soon as the problem is discovered, announce an irregularity in the movement just past the
halfway point, whatever round that happens to be. Tell the players to move normally for the round,
but not to start play; not to even pull the hands from the boards. Then:
1. Move the bye stand to its proper position (down 1).
2. Exchange sets of boards between the bye stand & the table now directly above. (This keeps the
boards in sequential order.)
3. Announce for this round & forward (except for the last round), the relay is between Tables 1 & 2
(not the highest & Table 1).
4. Resume play.
5. The last round would normally see E-W 2 play N-S 1. Instead, E-W 2 switches with the E-W
pair now sitting at the table that E-W 2 played at the round before the relay was changed. In
practice, this will be the table # = [(# rounds/2) + 1] (i.e. for 8 tables, Table 5, for 12 tables,
Table 7). Tables 1 & 2 no longer relay boards. Table 2 plays its normal last round boards
without relay. Table 1 still relays boards, but now with the table E-W 2 is now sitting at.
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Problem /
Pitfall

Avoidance Measures

Failing
to call a
skip at
the right
time

For 8 or more tables, there are at least 2 rounds when you can call the Skip.
In the opening Game Description,
8 tbls: rnds 3&4 10 tbls: rnds 4&5
announce when the Skip occurs; the
12
tbls: rnds 3 - 6 14 tbls: rnds 6&7
players will then tend to remind
16 tbls: rnds 5 - 8 18 tbls: rnds 4 - 9
you when they think it’s coming up.
If it’s not too late, call the Skip as soon as possible. Then use ACBLscore’s Set
In addition to mentally flagging the Configuration menu (<F9>) selection 5† to set the skip to the actual round after
Skip Round to myself, I note who
which the skip occurred.
E-W at Table 1 is. Then, with luck,
If it is too late—E-Ws fail to skip at the last opportunity—the E-Ws should
when I see them at the “skip after”
recognize they’ve played the boards before. When you’re notified of that, call an
table, I’m reminded that the skip
immediate halt and ascertain if any N-Ss have looked at their cards. If not,
round is coming up.
announce that all E-Ws should skip 1 table. If 1 or more N-Ss have seen their
Use ACBLscore’s Set
cards, move the boards a 2nd time in the normal rotation.
Configuration menu (<F9>)
selection 5† to set the skip as early
If you fail to catch the problem as indicated above, you’ll have to enter a score of
as possible.
NP when pairs encounter boards for the 2nd time.

6

Wrong #
of strata

When setting up the number of
strata, do not be misled by what
seems to be choice #2. It’s not
saying, “yes, stratify;” it’s saying,
“I want exactly 2 strata.”

ID

Problem / Pitfall

Avoidance Measures

Remedies

7

An incorrect player
name won’t clear

?? improve your spelling
& typing skills

Use the <F5> key repeatedly to clear out the entire N-S or E-W entry. Then
enter the right name(s). May have to clear both E-W & N-S. Doesn’t always
work.

ID

5

Remedies

If you inadvertently enter the wrong number of strats, you can fix things later (but
not too much later) by using the <F9> key (Set Configuration) and choosing
selection 10, Set masterpoint rating. You’ll have to drill down a few levels to
reach the entry for the number of strata. Be sure to correct the number of strata
before entering the player names.

†

After drilling down a few levels to the Select player board duplication option window, you’ll probably have to select Other to enter the round after
which the players should or actually have skipped. Earliest to Skip: # rounds – (# tables/2); latest to Skip: # tables/2.
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ID

Problem / Pitfall Avoidance Measures

8

Wrong strat
for a pair

ID

Problem /
Pitfall

Make a mental note of the
proper strat for the future

Remedies
Go back to the Names entry, reselect that pair, go to the 2nd member of the pair, and
repeatedly hit the <F5> key to delete the 2nd name. Reenter that person and select
the right stratum for the pair.

Avoidance
Remedies
Measures
Select the Edit pull-down menu (2nd from the left) and then Strata (ST). This selection brings up a table of
N-S and E-W names accompanied by the currently selected strata and the Masterpoints of either the pair
member with the most points or the average of the pair. You may either hit <F6> or use the arrow keys to
enter the stratum (STR) column. When finished with a pair, use the Up/Dn arrow keys to move within a
column. The <Tab> key toggles the cursor between N-S and E-W. If you don’t need to override
ACBLscore’s automatic stratification, the simplest thing to do is use the <F3> key to stratify the entire
table.

9

Wrong
strat for
lots of
pairs

ID

Problem /
Pitfall

Avoidance
Remedies
Measures

10

Tried to
change
strata
designation
letters

Never
select this
option.

ID

Problem /
Pitfall

Avoidance Measures

Remedies

11

Masterpoints
out of date

Be aware that ACBL tries to update masterpoint totals
by the 6th of each month; get in the habit of doing an
update around the 8th of each month

Since this is not an urgent problem, it should suffice to
refer you to the Updating Masterpoints in ACBLscore
article that you may have seen at www.vcbridge.org.

If you were testing the Configuration menu options and drilled down to Set config menu (<F9>), #11
Assign/change/show STRATA letters/field sizes, #2 Change strata designation letters, you found
yourself in an endless loop. If you select this option and can’t exit via either OK or CANCEL, try the
<Esc> key.
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Avoidance
Remedies
Measures

Problem / Pitfall

[ If boards have already been played, you
can no longer rearrange the boards so you
have a continuous flow of board numbers.
Perforce, the last board of each round will
be out of sequence from the rest. ]

First, if needed, use <F9> (Set Configuration) selection 5 to drill down to
correct the number of boards per round. Then, click the Edit pull-down
menu (2nd from left). Select Edit Movement (EDM) (last selection). Select
option 1: Display or reassign board sequencing and click OK. A matrix for
Board Setup for round one will pop up. Go through the matrix substituting
the actual last board of the round for the normal board that ACBLscore
assumed you’d placed at each table. (Typically, you’ll be changing the last
board in each column.) When done, hit <F9> or click OK.

13

Need to assign Average Plus (A+) or
Average Minus (A-) for both N-S and
E-W

When entering the scores, first hit the “S” key (for special scoring). For
average plus, next enter A+, first for N-S and then for E-W. For average
minus, next enter A-, first for N-S and then for E-W.

ID

Problem / Pitfall

Too few boards per table noted after
some boards have been played
12

14

Need to adjust the
matchpoints for a pair

Avoidance Remedies
Measures
Click the Edit pull-down menu (2nd from the left). Click Adjustments (about ⅔ of the way
down), which brings up the N-S and E-W pair names in a table very similar to the one used
to enter the player names. One difference is an ADJUST column has been added to the
right of each column of names. <F6> starts with N-S 1 and allows sequential entry of
adjustments (via the Enter key). Alternatively, use the arrow keys to select a specific pair,
then press the Enter key. Enter the adjustment for the pair and press the Enter key. When
finished, press <F9>.
Adjustments may be upward as well as downward. For a negative adjustment, you may
press the Minus key at the start of the numeric amount or at the end.

15

Wrong Club Number
discovered after scores
have been entered

You may continue with the <F9>, selection 10 solution and then carefully check all the
scores—they’ll probably be correct—or you can try the Import/Export feature of
ACBLscore as discussed next.
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(1) Rename the game file.
(2) Create a new game file using the proper Club #, and set up the Section appropriately.
(3) Click the File drop-down menu, and then Import / Export.
(4) Click on From another game file and specify the game file, the one with the scores in it,
newly renamed in step one (1).
(5) Generate an on-screen report to verify the results were as previously given.
(6) Delete the old, renamed game file.

If you’ve encountered any of the problems & pitfalls, i.e. any of the “Oh Shit” moments, covered by this paper, I hope the possible actions
to prevent and/or recover from them seem workable. Some of these problems are discussed in greater depth, including the reason they
might occur, in the paper titled Working with ACBLscore, which is available at www.vcbridge.org via the path: Writings, Director’s Dialog.
Look in the alphabetized table labeled Aids for the Director. The Updating Masterpoints in ACBLscore article cited in entry #11 is also in
that table.
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